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Introduction to SurfCAM 
 
The final quality of any milled piece is dependant on both a good quality CAD file, 
and a solid understanding of the milling techniques and processes that will be 
used in fabrication. 
  
SurfCAM is a software program used to translate digital geometry into milling 
tool-paths.  The CAD file may be either a line drawing file (DWG, or DXF) or a 
NURBS surface file (IGES file from Maya).  SurfCAM outputs the toolpaths as G-
code for the milling machine. 
  
SurfCAM can also be used as a ”Design & CAD” software, it has many features 
that are not typically used in the course.  Students are highly encouraged to 
explore the tools available within the software, and to find new uses for them in 
our architectural and ornamental context. 
 
 

 
File preparation rules from MAYA: 
 
The easiest way to ensure that the model will be contained properly within your stock (block of material) is to 
ensure that the model is in the positive x, y and the negative z area.  

 
1. Ensure that all work (to be cut INTO the piece) is either on or below the Z axis. 
2. Ensure that you know where the origin is in relation to the work to be cut. 
3. The mill and SurfCAM work with millimeters as the units. 
4. Ensure that you know the scale and units of your work, or create a reference line. 
5. If you work with NURBS surfaces and IGES export all will be good. 
6. If you work with Polygons - expect to process the work again within SurfCAM 

 
 

The (0,0,0) origin coordinate in digital space will be your reference 
origin on the milling machine, with z=0 as the top of your material. 
 
 

File Preparation of Maya surface models for SurfCAM: 
Ensure that the file you have generated in MAYA has been done with the Z axis set to up. (the default is for Y to 
up – from the animation industry!) 
 
Ensure that the model is in the positive x, y and the negative z area.  

- The (0,0,0) coordinate will be your origin on the milling machine, with z=0 as the top of your material. 
  
Export the active items (file> export selection) as an Iges file.  

- If the iges option is not listed in the settings, cancel the export action and check the export-setting. 
(windows> settings/preferences>plug-in manager>  turn on the iges export   < ) 

 
If exporting a NURBS or line project from MAYA save the file using the .IGES export. Once saved manually 
rename “iges“ to “.igs”.  SurfCAM will only find a file with the proper extension of .igs !  
 

 



SurfCAM       - start      
SurfCAM can read the following file types: 
 
DSN (*.DSN) 
SolidWorks (*.PRT, *.SLDPRT) 
DSN Fix (*.DSN) 
VDA (*.VDA) 
DES (*.DES)  
ASCII (*.asc) 
DXF (*.DXF)  
Ncc (*.ncc) 

IGS (*.IGS)  
Brn (*.brn) 
MESH (*.CDL)  
NCAL (*.NCA)  
Parasolid (*.X_T, *.X_B)  
Cam Profile Data (*.cm) 
SAT (*.SAT)  
DWG (*.DWG) 

 
The most common types that will be used are .DXF & .DWG for line work, and .IGS for NURBS Surfaces. 

 
Launch SurfCAM, click once on the image in the center of the screen = ready! 

- File>Open choose your file type in the file command, and then navigate to your saved location and 
choose your file. 

- Save the file as DEM Format (this ensures you have a saved version, and also sets up the folders for 
the operations manager (more on this later) 

- NOTE, in SurfCAM there is NO UNDO!!!!! Please SAVE as often as possible!!! 

 
The GUI:  

 



SurfCAM      - start  
 
View port configuration: 

– SurfCAM has basic viewport configuration. The basics of Zoom, Rotate view, Pan and Fit are all present 
on the Main toolbar. 

 

- There are two different views for the piece – think of them as the viewport view: View, and the Milling 
bit view: CView.  You must be careful to always match the views (usually to TOP = #1) when processing 
new tool paths. 

 
- This is easily accomplished by clicking on either view, selecting the view and clicking both buttons at 

the bottom of the selection window: VIEW + CVIEW and then OK 

 

      
Checking the scale of the object: 

Measure a known distance, and if necessary, calculate the scaling factor.  
NOTE: ALL MEASUREMENTS IN SURFCAM ARE IN MILLIMETERS!!! 
- Analyze> Distance> Sketch/Endpoints   
- If required apply a scaling factor to the entire drawing, be careful to maintain the position and 

orientation of the piece – scale about the origin! 

- Edit> Transform> Move> Scale> visible> Keyboard (0,0,0)  (+SAVE) 



SurfCAM   
 
Check the Surface Direction of your object: 

Check the surface side – the NORMAL of the surface should be positive(+Z of the mill). 
- Display> Shade> Undercut (red=wrong / green=right) In this mode you see if your surfaces 

are oriented in the “UP” direction and also if your model has and “undercuts”. 
-  
 

 
 
 
 
- Edit> surface> side> click on red surface 

•  Arrows (toggle on and off the side and direction indicators) 
•  direction (influence the fine cut direction) 
•  corner (determine the starting point of the fine cut) 
•  (+SAVE) 
•   
 

 
 
 
 



SurfCAM      
Prepare the file settings > Operations Manager 

The complete tooling of a single piece may often require several different toolpaths.  To organize the files 
and toolpaths set up the job in the operations manager. 

- Click the operations manager icon on the toolbar. (right-most button on the first bar) 
- Here you can set up folders for Z-rough cut, Z-fine cut,…. 
- left button creates new folder> create a fine- and a rough- folder)>  
- activate the rough folder. It will automatically put your NC jobs in this folder. 
-  

The Operations Manager allows you to view the structure of the job and do graphical verification of the 
milling jobs. 

 

 

Creating a NC job  
Most projects require several different cutting techniques to reveal a final product from a mass of material.  The 
usual sequence of cuts is  ROUGH CUT > CUT > FINISHING CUTS.   For two dimensional or very shallow (small Z 
height) jobs it is often possible to avoid using the rough cut, but for any product where you wish to cut deeper 
than the diameter of the cutting tool, you must use a rough cut. 
 
In addition to the cutting types, there are also some manual techniques that can assist in making your jobs go 
faster.  Manual adjustment of the Z=0 height can help fake a fast roughcut, and prevent tool or material 
breakage.  These will be demonstrated through the term as required. 



SurfCAM  
Generating toolpaths using SurfCAM: 
There are several different toolpath types that can be run on a 3 axis Precix mill.  To get best results for a piece 
several toolpath types may be combined and run in order. 
 
Different types of cutting that are supported on ourPrecix Mill: 
 
Cut: Cut and finish a single surface by following flow lines that define the surface 
 
Project: Project an existing toolpath from one design onto the surface of another design. 
 
Z-Rough:  Remove large amounts of material from around a part before other operations are used to do the 
finishing cut. 
 
Plunge Rough:  The Plunge Rough operation quickly removes a large amount of material. Plunge Rough 
removes the material with feed moves in Z only. A series of overlapping plunge moves are made that remove 
cylindrical plugs of material. The axial strength along the machine tool spindle allows for high feed rates than 
can be maintained with XY moves. 
 
Z-Fine: Cut multiple surfaces—most efficient at cutting surfaces or areas that are steeper or closer to being 
vertical. The Z Finish operation cuts a part by using a 2 axis (X,Y) contour cycle in Z axis increments. 
 
Planar:  Create toolpaths over multiple surfaces. There are two distinct types of Planar operation: Planar Type 

and Flow surface. 
Planar:  a linear fine milling of the project surface, all toolpaths are parallel and the mill moves with 
the surface in the Z axis. 
Planar – Flow:  A fine milling of the surface, however the toolpaths are calculated based on the 
inherent geometry and orientation of the U&V geometry within the NURBS surfaces. 

 
Contour 3D:  Perform cuts of 3D splines. Cutting along a 3d spline.  This will result in etching or cutting of 
material in 3d.  A sacrificial layer under the material should be used if the cut is to be completely through the 
material. Care must be taken that the line does not cut through the material such that the endmill is driven 
below the appropriate cutting depth. 
 
 
 
- Cutting types available in SurfCAM but NOT supported with our Precix post processor. 

 
Drill: Used to perform Z axis canned cycles including drilling, reaming, tapping and boring.  
 
Pilot Hole: In preparation for performing an operation that uses a tool that cannot cut material in a 

plunge move, use the Pilot Hole operation to drill pilot holes in a part. 
 
Auto Rough: Removes large amounts of material from around a part by using a 2 axis (XY plane) 

cutting cycle at incremental Z level depths. 
 
 
 

Creating a NC job  
>For this tutorial only the most commonly used options will be presented! 
> If an option is not presented here then it can be left as the default setting. 
> For all other options and methods please refer to the SurfCAM manual, available on the computers as 

a PDF in the help menu. 



SurfCAM – CUTS 
 
Creating a ROUGH CUT 
Rough cut is used to remove most of the excess material from a block and leave only a small layer of material 
above the actual desired surface.  This remaining layer with later be milled off using a “cut” or “finishing cut”  

- NC mode> 3axis> z-rough> “select/multiselect” use an option to select surfaces  
- Extents Box or Top Profile  

•  Extents Box> if your surface or part corresponds to the size of your material block. 
numerically input the diagonal coners of the material box. 

•  Box> if you have created a box in surfCAM to define your material.  Click on the 
corners of the cube to define the material box. 

•  Top profile> if you have drawn a polyline bounding curve to define the outside of 
the cutting area.  Click the start and end of the polyline so that the program can 
“chain” all the segments and identify the closed polyline. 

- Tool Information> select a tool (12mm, 6mm, 3mm - flat or round nose endmill) (DO NOT CLIK OK – 
use the tabs at the top of the box to move to the next page.) 

- Cut control>  
•  Method: conventional = soft material, climb = hard material 
•  Stock to leave: 0.75 – 2.0 mm depending on material 

– Amount of material left above the actual surface for the fine cut. 
•  Rapid plane: min =25 mm 

– The height above the 0 surface that the mill will move to before moving on to 
another area of the surface. 

•  Z-step size: max½ the diameter of the endmill being used. 
– Example 12mm ballnose, Z-step size = 6mm.  6mm flatnose = 3mm, 
– This is the vertical step distance for countour lines, optimal step size is 

dependant on the material being used. 
•  XY-step size: max½ the diameter of the endmill being used. 

– This is the horizontal step distance for countour lines, optimal step size is 
dependant on the material being used. 

•  Plunge Point Selection: Select or Automatic  
– Select = manual selection of  points where the mill is able to plunge into the 

material between the Z step sequences.  
– Automatic = the computer decides irregardless of material and endmill being 

used. 
- Pocket Options: 

•  Material Cut Mode: Spiral,      ZigZag,  or  Contour Cut 
•  Gouge Check Lead Move: Yes  

– ensures the endmill plunges into (enters) the material without marking other 
un-selected surfaces. 

- CLICK - “OK” 
 
After clicking OK, check the “prompt line” in the lower left corner of the screen. 
- if any additional action is required it will prompt you here, if not then it will show the progress of the job. 
- If prompted: Draw plunge points using the SKETCH setting (at Endpoints of the bounding box, between the 

bounding box and your model and in the deep areas of your model), then click “Done”  
- The program now calculates the toolpath and saves it into the Operations Manager. 
 
- SAVE!!!!!!!! 
Click on the Operations Manager Icon to ensure that the job was done successfully and placed in the 
appropriate folder.  It is also a very smart idea to name and organize all of your milling paths.  



Creating a Fine Cut 
- In the Operations Manager: Highlight the “Fine” folder that you made earlier, click DONE. 
- Double Check the direction of the surfaces (fine cut relies on NORMALS, rough cut doesn’t). 
- There are several different modes that can be used for the fine cutting of a surface, experiment 

with each to find texturing and finishing processes for your design. 
 
- NC mode> 3axis> cut> select the surface (in cut mode you must create individual sequences for each 

surface,which can be grouped later on in the operation manager) 
- Tool Information: select tool (6mm/ 3mm Ballnose or Flatnose Endmill) 
- Cut control>  

•  Stock to Leave: 0 mm (reveal the actual surface)  
•  Step Type = increment 
•  Step size: max½ the diameter of the endmill being used, But for a smoother finer 

surface this can be reduced but will increase the job running time. 
•  Retrace type: Bidirectional (back and forth on the surface) 
•  Rapid plane:  min10mm (as before) 
•  Gouge check:  None or Single or Multi-Surface 

– Gouge check is used to protect other surfaces surrounding the surface to be 
cut.  Special attention is paid to the edge conditions  to ensure no accidental 
marking to co-joined surfaces occurs. 

•  CLICK  “OK” 
•  If gouge check was set to Single-Surface or Multi-Surface then the user is 

prompted to identify which surfaces should be avoided – then click “DONE”. 
- SAVE!!!!!!!! 
 

- NC mode> 3axis> planar> select the surfaces (multiple surfaces may be cut in a single operation) 
- Tool Information:  

•  select tool (6mm/ 3mm Ballnose or Flatnose Endmill) 
- Cut control>  

•  Stock to Leave: 0 mm (reveal the actual surface)  
•  Rapid plane:  min10mm (as before) 
•  Minimum Zvalue: Set if required 
•  Step Type = increment 
•  Step size: max½ the diameter of the endmill being used, But for a smoother finer 

surface this can be reduced but will increase the job running time. 
•  Check Surfaces: yes 

– This is essentially the same as gouge check = surfaces to avoid. 
•  Cutting Direction: Planar or Flow 

– Planar: user defined parallel lines that define the surface in Z modulations. 
– Flow: cut path geometry based on the geometry of the NURBS surface. 

•  Retrace type: Bidirectional (back and forth on the surface) 
- CLICK  “OK” 

•  If check surfaces was set to “yes” then the user is prompted to identify which 
surfaces should be avoided – then click “DONE”. 

•  Planar: the user is prompted to choose 2 points to define the angle for the parallel 
line cutting paths, followed by a side of that line for offset. 

•  Flow Surface: the user is prompted to define a surface from which to gain the flow 
attributes from. 

- SAVE!!!!!!!! 
 
Click on the Operations Manager Icon to ensure that the job was done successfully and placed in the 
appropriate folder.   When executing many different cutting paths It is  a very smart idea to name and organize 
all of your milling paths.  It is also a good idea to group milling paths that use a common endmill cutting tool into 
a single folder, then the user can post the whole folder at once and minimize operator time.   



SurfCAM       
Creating a NC job (3d-contour cut) 

- NC mode> 3axis> contour-3d > select chain / visible/ within….  CLICK “DONE” 
- Tool Information:  

•  select tool (6mm/ 3mm Ballnose or Flatnose Endmill)  
•  program the sequence for tip or center 

- Cut control>  
•  Cutting Method > On Contour or On Top  
•  Stock to leave (offset in the vertical distance): 0 mm 
•  Rapid plane:  min10mm (as before) 
•  Minimum Zvalue: Set if required 

- CLICK  “OK” 
•  SurfCAM now calculates the toolpath and saves it into the Operations Manager. 

 
 
 

Simulation 
Once a tool path has be created in the Operations Manager SurfCAM Verify can be used to visualize the cutting 
process and ensure that the result is what is expected. 

Operation manager>Verify (Manual or Automatic)  
- Highlight the toolpath / folder / job > select the “Verify” button, or the “Verify in Auto Mode” button. 

 

- Manual Verify  
- When clicking on Manual Verify the Options box pops up in the upper right corner of the 

screen. 

 

- Add material to the scene: measurements should correspond to the material you have for 
milling. 

- Process the Visualization animation, then press the PLAY button. 

- AUTO Verify  
- Click the button, simulation begins automatically. 
- material is size to fit all toolpaths so may no accurately represent the actual material block. 

 

Simulation will represent real cutting being preformed. Errors and gouges 
will be shown red in the simulation. 



SurfCAM  
Post processing: 
Once all of the toolpaths have been calculated the job can be post processed.  Post processing is the act of 
translating the SurfCAM toolpaths format into the native Precix .gc G-Code format.  

- Open up the Operation manager. Simulate your NC jobs and check for any errors. 
- Highlight the Rough folder (or Fine folder), containing the jobs for one side or jobs that all have the 

same milling bit. They can be grouped as one job to be posted to the milling machine. 
- Ensure that the Precix mill and 3 Axis is set in the machine selection box. 
- Click Post 
- A window will be opened with your job written in g-code. 
- Change the first line of code –  

•  %   %  
•  S796  to  S12000 

- Select file> save as> save file as an appropriately descriptive “filename.gc’ (make sure you type the .gc 
end) 

 
G-Code is a standard used in the CNC machining industry.  It is a small set of relatively simple commands for 
moving  from one coordinate point to another.  With a very brief introduction it is possible to read and edit G-
Code Manually. 
 
It is also possible to program directly in G-Code using script generators.  There are several graphical 
verification tools available for native G-Code. 

 
 

Send file to the mill: 
- Check that the milling machine is switched on. 
- Start> Search>For files and folders  Cick Computers > search for computer precix.ethz.ch 
- double click the precix> double click files> copy your gc-files into the folder of the current month. 
- Please ensure that all of your work including the milling codes are backed up on CD or onto your 

personal account on the server 
- Do not leave data on the windows desktop – it may be deleted. 

 
 
 
 
 

Ready for Milling! 
 



SurfCAM CHEAT SHEET: 
15 steps to successful G-Code  
 

1. Ensure that you can import your desired file type into SurfCAM and that 
you use the appropriate “version” for the file type. (ex: rename .iges to .igs) 

2. Ensure that you know where the origin is in relation to the work to be cut. 

3. Load file into SurfCAM 

4. Double check the scale. SurfCAM and the mill work in millimeters. 

5. Load surface model files into SurfCAM and check surfaces for correct 
tangency, and double check the scale. 

6. Save! 

7. Always ensure that your CVIEW and VIEW are set to the same value and 
view point. 

8. Set up the operations manager as required. 

9. NC > 3Axis > Contour 3d: use a 12mm bit, 6mm step sizes 

10. 3Axis –Z rough, use a 12mm bit, 6mm step sizes 

11. 3 Axis – Cut, or fine cut, change the folder in the operations manager, use 
a round nose bit (as desired), smaller step sizes 

12. For deeper cuts you may be required to run the job twice, first with a 
“stock to leave” value >0 (contour rough cut) and again with the “stock to 
leave” =0. 

13. Save often! 

14. Verify the toolpaths in the Operation Manager verify mode. 

15. Post Process the job, save the G-code with an appropriate descriptive 
name + as a .gc file. 

 

If you in doubt about any of the settings in SurfCAM -  consult the HELP files and the 
PDF manual (installed on all computers). 

  


